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Purpose
The purpose of this document is to guide authors and reviewers in analyzing the accessibility of a PDF
document based on WCAG 2.0 AA.

Introduction
Original section 508 standards did not explicitly provide technical standards for electronic documents.
However refreshed standards do explicitly include electronic documents and must adhere to the specific
standards stated in the Web Content Accessibility Guidelines (WCAG 2.0). All public-facing documents
are required to be compliant when posted to a site, distributed across the agency, or used as a sole
means of information.
PDF has become a popular alternate to HTML for certain content, but with that comes extra care
needed to ensure all users have access to the same information. In order for a PDF to be accessible, both
the content and the back end structure must be free from issues that would alter or block information
to users with disabilities. In PDFs, the back-end structure is referred to as the Tag structure, and it allows
Assistive Technology (AT) users a way to interpret the content of the document in the same manner of a
typical user.
This guide aims to help those tasked with reviewing PDFs to ensure 508 compliance through WCAG 2.0
by showing the basic steps for checking a document in its final version. Checks are listed in order of
difficulty. Compliant and non-compliant examples are provided for each type of error.
Notes:
•
•
•
•

This guide does not address PDF forms.
The screenshots in this guide are from Acrobat XI and may appear different in other versions,
however the concepts are universal
The most common issues are listed with examples; for a full list go to the HHS Common
Accessibility issues to avoid page for PDF.
Certain WCAG 2.0 guidelines do not apply because of the exception stated in E205.4 of the ICT
Refresh, these are:
o 2.4.1 Bypass Blocks;
o 2.4.5 Multiple Ways;
o 3.2.3 Consistent Navigation;
o 3.2.4 Consistent Identification.
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Tools
The following table shows the tools most commonly used during testing at ASPA/DCD.
Tool Name

How it is Best Used

Adobe Accessibility
Checker

Adobe’s built in checker has logic that finds common tagging issues within
the PDF. While a clean check does not guarantee compliance, it is a good
check to get an overall feel.

PAC PDF
Accessibility
Checker 2.0

PAC is a tool that checks to ensure the PDF conforms to PDF-UA, an ISO
standard that is also referenced in the 508 refresh. While the checks are
good and give more coverage than the Adobe checker, there are a few that
the ASPA 508 team does not view as required fixes for either 508 or WCAG
2.0. However, the screen reader preview feature is a great tool for quickly
checking the tag structure, especially for ensuring the table structure.

Colour Contrast
Analsyer

The tool is used for measuring the exact color contrast between two colors.
It is best to visually identify text against background that seems to be low
then use the tool to measure the exact contrast ratio.

Coblis

Colbis is a color blindness simulator. It can be used when an evaluator feels
there may be an issue with conveying information through color. A screen
shot needs to be uploaded and run through the types of color blindness
tests Colbis provides.

How to Use a Tool to Evaluate a PDF
Tools included above are used specifically to fit into a process that identifies the greatest number of
issues in the least amount of time. These tools are not required for evaluation. If other tools are used,
the following types of, and progression through are encouraged:
1. Use a document scanning tool to find specific accessibility issues, and problematic areas of the
PDF.
2. Use regulation-specific tools to aid in evaluation of content appropriate to that regulation.
3. Use manual evaluation to supplement and confirm ALL results from automated tools.
Tools are used in our testing process to aid in the evaluation of the 508 standards for Information and
Communications Technology (ICT) and to increase efficiency. However, they are in no way a
replacement for the knowledge necessary to manually evaluate the results of automated checks within
the tools, nor is there a single or set of tools that alleviates the need to manually evaluate and use
human judgment to ascertain the accessibility of a website or piece of content.
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General Evaluation
Document Properties
Inspecting the document properties is a quick check to see if the most basic measure of accessibility,
PDF tagging, has occurred. It also indicates whether the document properties were properly filled out.
Steps to check
1.
2.
3.
4.
5.
6.

Open the PDF.
Select File > Properties.
In the description tab, look for the field ‘Tagged PDF’.
Ensure the field is set to Yes.
Inspect the Title, Author, and Subject fields.
Ensure the values are appropriate.

Common Issues
1. PDF is Untagged
2. Document Properties are Not Filled Out Properly

Correct Example
1. Tagged PDF values is Yes
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2. Title, Author, and Subject fields are populated (Author should be set to the owning Opdiv, office,
or simply DHHS)

Notes
•
•
•

•

An untagged PDF is not compliant; there is no need to perform the Tag inspection checks
outlined in this document when a PDF is untagged.
“Author” should always be the agency that produces the original document per HHS policy
You can also tell the source file on the properties window from the Application field. If it was not
originally Office, be sure to inspect Back-End Text carefully.
Additional Resources:
o Adobe Tagged PDF Error Help
o Adobe PDF Properties
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Back-End Text Errors
Though text may look accurate visually, on the back end there may be typos or additional spacing that
will cause screen readers to announce incorrect content. This can occur in any document, but is more
common to occur when a program other than Office was used to construct the original document.
Steps to check:
1.
2.
3.
4.
5.
6.
7.

Open the PDF.
Select File > Save as other > More Options > Text (Plain).
Select a save location.
Select Save.
Navigate to and open the text file in Word
Using built in tools for grammar and spell checking, look for typos or spacing issues
Compare results to the visual document.

Common Issues
1. Tagged text does not match visual text
“Follow these directionsto ensure a positive migration experience”

Correct Example
Text in the Word document matches the visual text of the PDF
Notes
•
•
•
•
•

This issue will NOT be caught by the Adobe Accessibility checker.
Reading order issues can also be spotted here, but they are easier to spot with the technique
further down in this document.
Alt text of images will be included in the document, so typos can be spotted there as well
Issues can be fixed in the PDF, but it’s better for authors to diagnose the issues in the source so
as to avoid in future documents.
The initial save as the text file seems to replicate the closest experience as to what assistivetechnology users’ experience, as such it is NOT recommended to save directly as a Word file in
this evaluation.
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Bookmarks
Bookmarks in long documents allow users to locate content benefiting not only those with cognitive
disabilities, but all users. HHS requires bookmarks for all PDF’s 10 pages or greater.
Steps to check:
1.
2.
3.
4.
5.
6.

Open the PDF
Determine if there are at least 10 pages in the document
Select the bookmarks icon
Determine if there are bookmarks
Expand and select a sample of bookmarks
Ensure the links are accurate

Common Issues
Bookmarks are not present on a document with 10 pages or greater

Correct Example
Bookmarks are present and accurate
Notes
•

Additional Resources:
o WCAG 2.0 PDF Technique 2
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Accessibility Checker
There is a built-in accessibility checker in Acrobat. Although it does not guarantee a compliant
document (even if it passes all checks), it does show basic errors. A fail for any of the checks means the
document is probably not compliant.
Steps to Check:
1.
2.
3.
4.
5.
6.

Open the PDF.
Select View > Tools > Accessibility.
Select Full Check and keep the defaults.
Select Start Checking.
Expand any category denoted with issues.
Inspect the results.

Common Issues
1.
2.
3.
4.

PDF fails general accessibility check
Tab Order is Not Specified
Primary Document Language not Set
Document Title is not Showing in Title Bar

Correct Example
There are no fails in the accessibility checker. Any issues flagged are ones that need manual checks:

U.S. Department of Health & Human Services

9

PDF 508 Guide HHS.gov

Notes
•
•

A clean report does not necessarily mean a compliant document, the tag structure must still be
inspected manually.
Most flagged errors are issues found in the tag tree. To further analyze the error, right click on
the error and select Explain. An Adobe help page will be displayed with an explanation and
instructions to fix.

•

To find specific instances of the errors, expand and select the individual elements which usually
highlights the element in the main view of the document when ‘highlight content’ is enabled.

•

If available, Show in Tags Panel and Show in Content Panel can take you directly to the element
with the issue.
Additional Resources:
o Adobe Accessibility Checker Help

•
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Evaluating Color
Before inspecting the tag structure, review the document page by page to inspect the content for visual
issues related to color.

Color Contrast for text
With the exception of logos, all text must have sufficient color contrast so it is easily visible to all users.
The preferred tool to measure the contrast is the Colour Contrast Analyser which is a free tool that
measures the contrast ratio between text and background. The minimum contrast ratio for text of all
size at HHS is 4.5:1.
Steps to Check:
1.
2.
3.
4.
5.

Open the PDF.
Go page by page and identify any color schemes with seemingly low color contrast.
Use the Contrast tool to capture the color of the background adjacent to the text.
Use the Contrast tool to capture the color of the text.
Analyze the contrast ratio to ensure a value of at least 4.5:1.

Common Issues
Color Contrast is Insufficient

Correct Example
Contrast ratio of text against background is at or greater than 4.5:1
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Notes
•
•

This issue will NOT be caught by the Adobe Accessibility checker.
HHS requires all text, no matter the size, to have a contrast ratio of 4.5:1 or greater. Therefore,
the Pass/Fail values in the tool should be ignored.

•

In cases where background or text color varies at different points (e.g. a gradient), use the
lowest measurement as the contrast ratio value.
This maps only to WCAG 2.0 and is the only issue currently required by HHS that does not map
directly to Section 508 standards.
Additional Resources:
o WCAG 2.0 Understanding 1.4.3
o Webaim - Contrast

•
•
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Conveying Information with Color
No information should be conveyed with color alone. There must be a non-color method available so
colorblind users can access all information.
Steps to Check:
1. Open the PDF.
2. Go page by page and identify any color information which may be conveyed with color.
3. Analyze the content itself and surrounding content to see if the same information is conveyed
without the use of color.
4. For content where it’s hard to tell, print in black and white and analyze the hard copy.
Common Issues
1. Distinctions Beyond Color-Only are Missing
List of 5 mammals, heavy ones appear in red
• Cat
• Elephant
• Dog
• Hamster
• Whale
2. Charts/Graphs rely on color only legend

Correct Example
Pie chart uses visual labels in addition to a color only legend
U.S. Department of Health & Human Services
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Notes
•
•

•
•

This issue will NOT be caught by the Adobe Accessibility checker.
An alternative to the print in black/white test is to take a screenshot of the content and run it
through a simulator such as Coblis to verify that no information is missed by ANY colorblind
types.
Surrounding text or data tables with equivalent information are considered non color methods
for charts/graphs.
Additional Resources:
o WCAG 2.0 Understanding 1.4.1
o Webaim - Color-blindness
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Link Color
When reviewing hyperlinks, be sure to consider the following:
•
•

First, whether the hyperlink a different color from the surrounding text. It should be a different
color and contain a contrast greater than 3:1 when compared to surrounding text.
Second, whether the actual linked text is understandable within the context of the surrounding
text. It should either be understandable on its own, or be in the same tag with text that gives
sufficient context.

Steps to check:
1. Open the PDF.
2. Inspect the PDF for links that are distinguished by color (and do not have another distinguisher
such as an underline).
3. Ensure the link has contrast greater that 3:1 when compared to surrounding text.
4. Inspect the link text.
5. Ensure link text is either understandable on its own or is understandable within the context of
the surrounding text (surrounding text must be in the same tag).
Common Issues
1. Links are Only Identified Visually by Color

2. Generic Link Text is Present

In this case context is not sufficient because the link is in a separate paragraph tag.
Correct Example
The hyperlink “register with Grants.gov” text is understandable out of context. Though it is blue, it is
always underlined in addition to having sufficient contrast from surrounding text (only 1 is needed to be
sufficient).
U.S. Department of Health & Human Services
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Notes
•

•

Automated tools can aid in the inspection as some show the presence of generic text. However,
manual inspection is required to determine whether the link has enough surrounding context
and whether links have a non-color indicator or sufficient contrast from the surrounding text.
Additional Resources:
o WCAG 2.0 General Technique 183
o WCAG 2.0 Understanding 2.4.4
o WCAG 2.0 Failure 63
o Webaim - Links

U.S. Department of Health & Human Services

16

PDF 508 Guide HHS.gov

Evaluating the Tag Structure
Inspecting the tag structure is the most demanding part of checking a PDF for accessibility, but it is also
the most important as it defines how assistive technology is going to announce the content of the
document to users. The steps below rely on only inspecting the tag tree, as sometimes there is a conflict
(especially when checking for logical order) between the tree and the touchup reading order tool. In
these cases, the tag tree is always the most reliable. Some of these issues also may be flagged by the
accessibility checker.
Alternatively, the PAC tool screen reader preview feature can be used to evaluate the tag structure and
some may find it to be more usable.
To access the tag structure, select the tags icon in the navigation pane.

Note: If a PDF is untagged, it is automatically inaccessible

U.S. Department of Health & Human Services

17

PDF 508 Guide HHS.gov

Order & Inclusion
Ensure the order of the content in the tag structure is logical. The order in the tag structure is the order
assistive technology will announce the content. Also ensure all informational content is contained within
the tree structure.
Steps to Check:
1.
2.
3.
4.

Open the PDF.
Select the Tags icon.
Use the down arrow key to go line by line.
Compare the order of the content (denoted with a box icon) in the tags tree to the typical visual
reading order.
5. Ensure logical reading order.
6. Ensure all informational content is tagged.

Common Issues
1. Tag Structure does not reflect Logical Reading Order

2. Informational content is not Tagged

3. Informational Image is tagged as background
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Correct Example
All informational content is tagged and appears in a logical order when navigating the tags tree
Notes
•
•
•
•

These issues will generally NOT be caught by the Adobe Accessibility checker.
Though it is important to go by the tag structure, the touchup reading order tool can show
content that is not tagged (as seen in the screenshots in common issue 2 and 3).
Alternatively, the PAC tool screen reader preview feature can be used to evaluate reading order
Additional Resources:
• WCAG 2.0 PDF Technique 3
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Figures
A figure is an image, which can be a screenshot, photograph, drawing, chart or a graph. Some figures are
important and convey information while others add no information (non-informational) to the
document content. Informational figures should be contained in the Figure tag.

Steps to Check:
1.
2.
3.
4.
5.
6.
7.

Open the PDF.
Select the Tags icon.
Find all figure tags.
Ensure that the content is appropriate as an image.
Right click on the figure tag and select Properties.
Compare the Alternative text field to the figure.
Ensure the alt text captures all information that can be obtained by a visual user.

Common Issues
1. Image is Missing Alternative Text

2. Alternative Text is Incorrect
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3. Decorative Images are not Tagged as Background

4. Complex Images are Missing Detailed Descriptions
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5. Content is an image of a data table or text instead of an actual data table or text

Correct Example
An informational image is tagged as a figure and the Alternate text in the properties of the figure tag
conveys the same information gained by a sighted user.

Notes
•
•
•

•

The Adobe Accessibility checker can find figures that have no alt text but manual inspection is
needed to determine if the alternative text of figures is accurate.
For complex charts and graphs, descriptive text is necessary. Describe exactly what the
chart/graph is depicting along with detailed data and trend information.
There is no official limit on the alt text field, however best practices recommend limits ranging
from 120-250 characters. As such, complex images should adhere to the following guidelines:
• WCAG 2.0 Complex image tutorial
• Webaim - Complex Images
Additional Resources:
• WCAG 2.0 PDF Technique 1
• WCAG 2.0 PDF Technique 4
• WCAG 2.0 Understanding 1.4.5
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Headings
Visual Headings and subheadings indicate titles or sections of a PDF document. When used, assistive
technology users must have a way to understand that a piece of text is a heading. Visual headings
should be contained in Heading tags (H1 to H6) in hierarchical order.

Steps to Check:
1.
2.
3.
4.
5.
6.
7.
8.

Open the PDF.
Select the Tags icon.
Use the down arrow key to go line by line.
Compare visual heading text to the tags used.
Compare heading tags used to the visual text.
Ensure heading tags are used for all visual headings.
Ensure the appropriate heading level is used.
Ensure the text of the heading accurately describes the section of content.

Common Issues
1. Heading Tags are Missing

2. Heading levels Improperly Structured and/or skipped

3. Heading tags used on decorative text
U.S. Department of Health & Human Services

23

PDF 508 Guide HHS.gov

Correct Example
Visual headings are tagged with heading tags and follow a logical progression.

Notes
•
•
•

The Adobe accessibility checker will flag heading tags that are out of order, but manual
inspection is needed to determine if visual headings are using heading tags.
Heading Level 1 (h1) tag should preferably be for the main title of the document.
Additional Resources:
o WCAG 2.0 PDF Technique 9
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Lists
A list is text such as short phrases, single words, sentences or paragraphs that are grouped together as a
category. They are often distinguished by numbers, letters and/or bullets. Visual lists should be
contained in structured list tags.

Steps to Check:
1.
2.
3.
4.
5.

Open the PDF.
Select the Tags icon.
Find all List tags.
Compare visual lists to the tags used.
Ensure the list structure accurately portrays the visual list.

Common Issues
1. Visual lists are incorrectly tagged

2. Multiple List Items are Combined

3. List items are broken into multiple list structures
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Correct Example
A visual list contains a single List tag that includes 1 LI tag per item, which contains a label tag for the
number and a Lbody tag for the content. (Label tags are optional but encouraged).

Notes
•

•

The Adobe accessibility checker will flag List tags that do not follow proper structure, but
manual inspection is needed to determine if proper List tags were used and are reflective of the
visual content.
Additional Resources:
• WCAG 2.0 PDF Technique 21
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Links
URLs should be accessible to all screen readers; they must function as active links that have been
correctly tagged in the PDF. The link must provide a connection to the target site. Link text and the
hyperlink tag should be contained in the Link tag.

Steps to Check:
1.
2.
3.
4.
5.
6.

Open the PDF.
Select the tags icon.
Find all link tags.
Ensure the proper link text is contained in the Link tag.
Ensure a LINK-OBJR tag is included in the link tag.
Ensure the link goes to the correct destination.

Common Issues
1. Link tags are missing from tag structure

2. Link-OBJR tag is not present in the Link tag

3. Link text is not accurately reflected in the Link Tag

Correct Example
A paragraph contains a link where the link tag contains the visual link text and the appropriate Link –
OBJR tag.
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Notes
•
•
•

The Adobe Accessibility checker will flag physical links that have not been tagged, but manual
inspection is required to verify proper link text and correct destination.
Look out for URLs that spread across more than one line, sometimes they can be broken
Additional Resources:
o WCAG 2.0 PDF Technique 11
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Link Text
Descriptive link text lets users know where they will be going if they activate the hyperlink. Whenever
possible, the link text should be descriptive enough to be understood out of context. However, at
minimum, proper context must be given in the surrounding text when generic link text is used.
Steps to Check:
1.
2.
3.
4.

Open the PDF
Find all links
Ensure link text is understandable out of context
If it is not, ensure the surrounding text gives enough context to understand the purpose of the
link
5. Ensure the surrounding text and the link tag are contained in the same parent tag

Common Issues
A generic link has no context

A generic link has context, but is contained in a separate tag

Correct Example
Link text has content and the destination is understandable without the context

Notes
•
•
•

Manual inspection is required
Check the properties of the Link tag, an acceptable method is to provide alternate text to the
link
Additional Resources:
• WCAG 2.0 Genral Technique 53
• WCAG 2.0 General Technique 91
• WCAG 2.0 PDF Technique 13
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Standard vs. Alternate Tags
Role mapping allows you to add, change, and delete uniquely defined tags. Mapping custom tags to
predefined tags in Acrobat ensures correct announcement to a screen reader user.
Steps to Check:
1.
2.
3.
4.
5.
6.
7.

Open the PDF.
Select the Tags icon.
Use the down arrow key to go line by line.
For alternate tags, compare the alternate tag to the content.
Open the Role Map.
Analyze the role mapping of the alternate tag.
Ensure the alternate tag maps to the appropriate Adobe tag.

Common Issues
Nonstandard Tags are Used and Improperly Mapped

Correct Example
Nonstandard tags are used but properly associated to the standard adobe tags.
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Notes
•
•

These issues will generally NOT be caught by the Adobe Accessibility checker.
Most custom tags are generated through the conversion from the source file to the PDF.
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Tables
A table is a systematic way to display data in rows and columns. For tables to be understood by users of
assistive technology, header cells must be defined and related to data cells. Visual data tables should be
contained in structured table tags.

Steps to Check:
1.
2.
3.
4.
5.
6.
7.

Open the PDF.
Select the Tags icon.
Use the down arrow to go line by line.
Compare visual tables to the tags used.
Ensure the table structure accurately portrays the visual table.
Ensure all header cells are tagged with TH.
If there is 1 set of column and 1 set of row header cells:
a. Open the properties of each header cell.
b. Ensure the appropriate scope attributes are correctly implemented on the TH cells.
8. If there is more than 1 set of column and/or row header cells,
a. Open the properties of each header and data cell.
b. Ensure each TH cell has an ID attribute and is correctly related to the appropriate data
cells.
9. Compare Table tags to the visual text.
10. Ensure Table tags are only used on data tables.

Common Issues
1. Tables Used for Layout Purposes
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2. Incorrect Table Structure

3. Table Headers Missing TH Tags

4. Table Header Cells are not correctly associated with Data Cells
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Correct Example
A visual table is correctly structured with a single Table tag, appropriate number of Table Row tags, and
Table cell tags. Header cells are marked as TH, data cells are marked as TD. Column and Row header
cells are properly scoped.

Notes
•

•

The Adobe Accessibility checker will flag tables that do not have at least 1 TH cell, but manual
inspection is required to verify proper table structure and association of header cells to data
cells.
Use the Table Editor in the Touch Up Reading Order tool and to aid in the evaluation of table
structure and association of header to data cells. The lines drawn by the table editor should
match the intended structure of the table.
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•

An alternate to the table editor is to use the PAC tool screen reader preview (This is especially
useful for more complex tables which may need special values set for cells that span rows or
columns)

•

There are two methods to get to the needed properties of a cell. In the table editor, right click
the cell and select “Table Cell Properties”

•

However, because of structure issues, sometimes the table editor can’t be used. In those cases,
right click the cell in the tag structure and select Properties > Edit Attribute Objects
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•

Additional Resources:
o WCAG 2.0 PDF Technique 20
o WCAG 2.0 Tables Tutorials
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Paragraphs
A paragraph is a block of text within the document. Each visual paragraph should be tagged as a
paragraph.
Steps to Check:
1.
2.
3.
4.
5.

Open the PDF.
Select the Tags icon.
Use the down arrow key to go line by line.
Analyze the paragraph tag in relation to the highlighted content on screen.
Ensure the paragraph tag accurately represents the visual text.

Common Issues
1. Paragraph Tagging is Insufficient

2. Paragraph Tagging is Excessive

Correct Example
A single paragraph tags is used for a single visual paragraph.
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Notes
•
•

For paragraphs which run onto the next page, make sure to tag under the same paragraph tag to
keep the paragraph flowing.
Converted files may contain extra empty <p> tags. Remove these by changing them to artifacts
and deleting the tag.
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Language of Foreign Words or Phrases
If there are foreign words or phrases in the document, then the language of the tag that contains the
word or phrase must be set to the correct language.
Steps to Check:
1.
2.
3.
4.
5.

Open the PDF.
Inspect the document for foreign words or phrases
Find the tag containing the foreign word or phrase
Right click and select Properties
Ensure the Language is correctly set

Common Issues
Foreign words or phrases have the default language of the document:

Correct Example
The tag containing the foreign phrase has the language correctly set in the properties:
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Notes
•

Additional Resources:
• WCAG 2.0 PDF Technique #19
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Footnotes and Endnotes
Footnotes or endnotes are a combination of a reference in the main body of the document that cite a
note on the bottom of the same page or at the end of a document, connected by a unique identifier. It is
important to ensure not only the citation and notes are tagged correctly, but also the reading order is
logical so that screen reader users understand the sentence in relation to the reference.

Steps to Check:
1.
2.
3.
4.
5.
6.

Open the PDF.
Select the Tags icon.
Compare visual Footnotes to the tags used.
Ensure the reference number / letter / etc. in the paragraph uses the reference tag
Ensure the actual footnote uses the Note tag
Ensure the Note tag either follows the reference tag, or follows the tag containing the reference
tag
7. If endnotes are used, repeat steps 3 and 4.
8. For endnotes, they can either be in individual note tags, or part of a list structure.

Common Issues
References and Notes are tagged as flat text

Notes interrupt an unrelated paragraph
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Correct Example
A Reference tag is used on a citation and a child of the paragraph tag. A note tag is used on the footnote
and it immediately follows the paragraph tag that contains the reference. Optionally, a label tag is used
on the citation number within the note tag.
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Notes
•
•
•
•

If Footnotes or Endnotes contain physical links, then the link-OBJR should be a child of the
reference tag
It is recommended that footnotes do not contain physical links
In most cases, it is recommended that the note follow the tag containing the reference tag
rather than following the reference tag to preserve the meaning of the original sentence
Additional Resources:
• PDF32000_2008
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Table of Contents
A table of contents provides users an overview of the main information in the document and the ability
to quickly navigate to those sections.

Steps to Check:
1.
2.
3.
4.

Open the PDF.
Select the Tags icon.
Compare visual table of contents to the tags used.
Ensure the table of contents tags accurately portrays the visual items.

Common Issues
Table of Contents tagged as flat text
Correct Example
A visual table of contents is contained in a single TOC tag and each visual item is contained in a TOCI tag.

Notes
•
•
•

Multiple table of contents can exist in a single document, for example if there is an additional
list of tables, figures, etc.
If the table of contents is physically linked, each Link-OBJR should appear in the Link/Reference
tag for each table of contents item
Additional Resources:
• WCAG 2.0 General Technique 64
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Tips and Tricks
A couple tips and tricks to help in the evaluation of PDFs for Section 508:
1. To get a full view of the tag structure, click on the
plus sign while holding down Shift
+ Ctrl.
2. For larger documents, inspecting a single piece of content can be difficult as it takes time to
manually find it in the tag tree. In these cases, the following method can be used to quickly
locate.
• Select View > Tools > Accessibility.
• Select Touchup reading order.
• Use the mouse to put a box around a piece of content.
• Select the Tags icon.
• Select the Options icon.
• Select ‘Find Tag from selection’.
• The highlighted content will be shown (if it exists) in the tags tree.
3. Use the PAC tool to evaluate Table structure.

Additional Resources
•
•
•
•

PDF techniques for WCAG 2.0
Adobe accessibility help
HHS Making files accessible
Webaim – PDF Accessibility
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